
Advance Excel for 
Data Analysis



What if Analysis



WHAT-IF 
ANALYSIS

• What-if analysis in Excel refers to the process
of exploring different scenarios and assessing the
potential outcomes by changing input values in a
worksheet.

• It allows users to analyze the impact of these
changes on formulas, calculations, and results. By
adjusting variables such as cell values, formulas, or
assumptions, users can simulate various "what if"
scenarios to better understand how different factors
influence the results.

• This analysis helps in decision-making, forecasting,
and planning by providing insights into the potential
consequences of different choices or circumstances.



WHAT-IF ANALYSIS

Scenario Manager: It enables you 
to create and manage different 
scenarios by changing specific input 
values and viewing the 
corresponding results.

Goal Seek: This feature helps you 
determine the input value needed 
to achieve a specific goal or desired 
result.

Data Table: It allows you to see 
multiple results based on different 
combinations of input values by 
creating a table of possible 
outcomes.

Solver: It is an advanced tool that 
allows you to optimize a solution by 
adjusting multiple variables while 
considering constraints and 
objectives.



SCENARIO MANAGER

Scenario Manager is a what-if analysis tool in Excel that allows you to create, manage, and compare different scenarios by
changing input values and analyzing their impact on formulas and results. It is particularly useful for assessing how changes in
variables can affect outcomes and making informed decisions based on those insights.

Here's how Scenario Manager works:

• Define Scenarios: Start by identifying the variables you want to change or test in your analysis. These variables can include
cell values, formulas, or assumptions.

• Create Scenarios: With the Scenario Manager, you can create multiple scenarios by specifying different values for the
variables identified in step 1. Each scenario represents a specific combination of input values.

• Manage Scenarios: The Scenario Manager provides an interface to organize, edit, and view your created scenarios. You
can add, delete, or modify scenarios as needed. You can also assign names and descriptions to scenarios to provide
additional context.

• View Results: Once you have defined and created your scenarios, you can easily switch between scenarios to observe the
corresponding results. This allows you to compare outcomes and assess the impact of different variables on your
calculations.

• Scenario Summary: Excel also provides a Scenario Summary report that displays a summary of the input values and results
for each scenario. This report helps you visualize and analyze the variations among different scenarios.



GOAL SEEK

Goal Seek is a what-if analysis tool in Excel that helps you determine the input value needed to achieve a specific target or goal in a
formula. It allows you to work backward from a desired result and find the value that will make the formula yield that result.

Here's how to use Goal Seek in Excel:

• Identify the Goal: Start by determining the desired outcome or target value that you want to achieve. This could be a specific
value in a cell, a desired formula result, or a particular value in a formula-driven cell.

• Set up the Formula: Enter the formula in the appropriate cell that calculates the result you want to achieve. Make sure the
formula references the cell that you want to adjust.

• Access the Goal Seek Dialog Box: Go to the "Data" tab in the Excel ribbon, and under the "Data Tools" section, click on "What-If
Analysis." From the dropdown menu, select "Goal Seek."

• Configure Goal Seek: In the Goal Seek dialog box, you need to specify three components:

1. Set Cell: Enter the cell reference containing the formula result you want to achieve.

2. To value: Enter the desired target value that you want to obtain.

3. By changing cell: Specify the reference of the cell that you want to adjust in order to reach the target value.

• Perform Goal Seek: Click on the "OK" button in the Goal Seek dialog box. Excel will analyze the formula and iterate through
different values in the changing cell until it finds a value that achieves the desired result.

• View the Result: Once Excel finds a solution, it will display a Goal Seek Status dialog box showing whether it was successful or not.
If successful, you will see the adjusted value in the changing cell, bringing you closer to your target.



DATA TABLE

A data table is a what-if analysis tool in Excel that allows you to explore various outcomes by calculating multiple results 
based on different combinations of input values. It is used to analyze the impact of changing variables on formulas or 
functions in your worksheet.

Here's how to use a data table in Excel:

• Set up Input Values: Organize your input values in a column or row. These values represent the different scenarios or 
combinations you want to analyze.

• Define the Output Formula: Enter the formula or function that you want to analyze in a cell. This formula should refer to 
the input values you set up in the previous step.

• Select Data Table Range: Choose a range of cells where you want the results to appear. This range should correspond to 
the dimensions of the input values and the output formula.

• Create the Data Table: With the output formula cell selected, go to the "Data" tab in the Excel ribbon, and under the "Data 
Tools" section, click on "What-If Analysis." From the dropdown menu, select "Data Table."

• Specify Input Values: In the Data Table dialog box, you need to specify the cell range containing the input values you set 
up in step 1. Enter the cell reference or select the range using the cell range selector.

• Generate the Data Table: Click on the "OK" button in the Data Table dialog box. Excel will populate the selected range with 
the calculated results for each combination of input values. Each result corresponds to a specific scenario or combination.



SOLVER

Solver is an advanced what-if analysis tool in Excel that helps you find the optimal solution to complex problems by adjusting multiple variables while considering constraints and 
objectives. It is particularly useful for optimization and decision-making tasks where you need to maximize or minimize a particular outcome.

Here's an overview of how to use Solver in Excel:

• Identify the Problem: Define the objective function that you want to optimize and the constraints that must be satisfied. The objective function is the value you want to maximize or 
minimize, and constraints are the limitations or conditions that must be adhered to.

• Set up the Worksheet: Organize the variables, objective function, and constraints in a worksheet. Assign appropriate cell references to the variables, set up the formula for the 
objective function, and specify the constraints using formulas or cell references.

• Access the Solver Add-in: Go to the "Data" tab in the Excel ribbon, and under the "Analysis" section, click on "Solver." If Solver is not installed, you may need to install it from the Excel 
Add-ins.

• Define the Solver Parameters: In the Solver Parameters dialog box, specify the following:

• Set Objective: Select the cell containing the objective function.

• To: Choose whether you want to maximize or minimize the objective function.

• By Changing Variable Cells: Select the range of cells representing the variables that Solver can adjust to optimize the objective function.

• Subject to the Constraints: Define the constraints by adding them one by one or by selecting ranges containing the constraint formulas.

• Configure Solver Options: Set additional Solver options such as the solving method, precision, and convergence criteria, depending on the complexity and requirements of your 
problem.

• Solve the Problem: Click on the "Solve" button in the Solver Parameters dialog box. Excel will analyze the problem and attempt to find the optimal solution by adjusting the variable 
cells while satisfying the constraints.

• Review the Solution: Once Solver completes the optimization process, it will display a Solver Results dialog box. This dialog box shows the status of the solution, the optimized value of 
the objective function, and the values of the variable cells that yield the optimal solution.



Statistics



Descriptive 
Statistics

Descriptive analytics is a branch of analytics that focuses on summarizing 
and interpreting historical data to gain insights and understand patterns, 
trends, and relationships within the data. It involves analyzing past and 
current data to provide a clear understanding of what has happened in a 
particular context.

Descriptive analytics does not aim to provide explanations or predictions 
but focuses on exploring and describing the data to gain insights and 
inform decision-making. It forms the foundation for more advanced forms 
of analytics, such as predictive and prescriptive analytics, which involve 
forecasting future outcomes and providing recommendations for actions.

Overall, descriptive analytics helps businesses and organizations 
understand historical data, identify key performance indicators (KPIs), 
detect patterns and anomalies, and gain a comprehensive view of their 
operations, customers, and markets. By analyzing and visualizing data, 
decision-makers can make informed decisions and take appropriate actions 
based on the insights obtained from descriptive analytics.



TYPES OF DESCRIPTIVE STATISTICS

• These statistics provide information about the center or average of a dataset. The three 
most commonly used measures of central tendency are Mean, Median and mode.

Measures of Central Tendency:

• These statistics quantify the variability or spread of data points. They help understand 
how the data points are distributed around the central tendency. Some common 
measures of dispersion include Range, Variance and Standard Deviation.

Measures of Dispersion:

• Percentiles divide a dataset into equal parts, indicating the percentage of data points that 
fall below a certain value. Common percentiles include the 25th percentile (lower 
quartile), 50th percentile (median), and 75th percentile (upper quartile).

Percentiles:

• Skewness measures the asymmetry of a dataset's distribution. It indicates whether the 
data is concentrated more on one side or the other. Positive skewness indicates a longer 
right tail, while negative skewness indicates a longer left tail.

Skewness:

• Kurtosis measures the shape of the distribution and indicates the presence of outliers or 
extreme values. High kurtosis indicates a sharper peak and heavier tails compared to a 
normal distribution.

Kurtosis:

• This type of descriptive statistic displays the number of times each value appears in a 
dataset. It helps in understanding the distribution and identifying patterns.

Frequency Distribution:

• These statistics are used when analyzing the relationship between two or more 
categorical variables. They summarize the frequencies or proportions of different 
combinations of categories.

Crosstabulations and Contingency Tables:



MEASURES OF CENTRAL TENDENCY

Measures of central tendency are statistical measures that provide information about the center or average of a dataset. They summarize the typical or
central value around which the data points tend to cluster. The three most commonly used measures of central tendency are the mean, median, and mode

1. Mean: The mean, also known as the arithmetic average, is calculated by summing up all the values in a dataset and dividing it by the total number of
data points. It is affected by extreme values, or outliers, as it considers all values equally. The formula for calculating the mean is:

Mean = (Sum of all values) / (Number of values)

The mean is widely used and provides a balanced representation of the data when the distribution is relatively symmetrical.

2. Median: The median is the middle value that separates the higher and lower values in a dataset. To find the median, the data points are first arranged
in ascending or descending order. If the dataset has an odd number of values, the median is the middle value. If the dataset has an even number of values,
the median is the average of the two middle values. The median is not affected by extreme values, making it a robust measure of central tendency. It is
especially useful when the dataset contains outliers or when the distribution is skewed.

3. Mode: The mode is the value or values that occur most frequently in a dataset. In other words, it represents the peak(s) of the data distribution. A
dataset can have one mode (unimodal), two modes (bimodal), or more (multimodal). It is possible for a dataset to have no mode if no value repeats. The
mode is useful for categorical or nominal data, but it can also be applied to quantitative data. Unlike the mean and median, the mode does not provide a
measure of central tendency based on numeric values but rather identifies the most commonly occurring value(s).



EXCEL FUNCTIONS FOR MEAN, MEDIAN AND MODE

Mean:

Function: AVERAGE

Syntax: AVERAGE(number1, [number2], ...)

This function calculates the arithmetic mean or average of a range of
numbers.

Median:

Function: MEDIAN

Syntax: MEDIAN(number1, [number2], ...)

This function calculates the median of a range of numbers. It finds the
middle value in a sorted dataset or the average of the two middle values if
the dataset has an even number of values.

Mode:

Function: MODE.MULT or MODE.SNGL

Syntax: MODE.MULT(number1, [number2], ...) | MODE.SNGL(number1, [number2], ...)

MODE.MULT returns an array of all the modes in a dataset (if there are multiple modes), while MODE.SNGL returns the single most common mode.

These functions calculate the mode of a range of numbers. If there are multiple values with the same maximum frequency, MODE.MULT returns all
the modes, whereas MODE.SNGL returns the first mode encountered.



MEASURES OF DESPERSION

Measures of dispersion, also known as measures of variability, describe the spread or dispersion of data points within a dataset. They provide information
about how the values are distributed around the central tendency (such as the mean or median) and help understand the extent to which data points
deviate from the average. The main measures of dispersion include range, variance, and standard deviation.

1. Range: The range is the simplest measure of dispersion and represents the difference between the maximum and minimum values in a dataset. It
provides a quick and straightforward understanding of the spread of the data. However, the range does not take into account the distribution of values
between the minimum and maximum, making it sensitive to outliers.

2. Variance: Variance measures the average of the squared differences between each data point and the mean. It considers all values in the dataset and
quantifies the overall dispersion. The formula for calculating variance is:

Variance = (Sum of squared differences from the mean) / (Number of data points)

The squared differences are summed up and then divided by the number of data points to obtain the average. Variance is expressed in square units, which
may not be easily interpretable in the original units of the data.

3. Standard Deviation: The standard deviation is the square root of the variance. It measures the average amount of dispersion or variability in the dataset
and is expressed in the same units as the original data. The formula for calculating the standard deviation is:

Standard Deviation = √(Variance)

The standard deviation provides a measure of how spread out the data points are from the mean. It is widely used due to its interpretability and ability to
capture the dispersion of the data.



EXCEL FUNCTIONS FOR RANGE, VARIANCE AND SD

Range:

Function: MAX and MIN

Syntax: MAX(number1, [number2], ...) and MIN(number1, [number2], ...)

Example: =MAX(A1:A10)-MIN(A1:A10)

The MAX function returns the maximum value in a range, and the MIN
function returns the minimum value. By subtracting the minimum value
from the maximum value, you can calculate the range.

Variance:

Function: VAR.P or VAR.S

Syntax: VAR.P(number1, [number2], ...) or VAR.S(number1, [number2], ...)

Example: =VAR.P(A1:A10) or =VAR.S(A1:A10)

The VAR.P function calculates the population variance, assuming the dataset is
a sample from a larger population. The VAR.S function calculates the sample
variance. These functions return the variance of a range of numbers.

Standard Deviation:

Function: STDEV.P or STDEV.S

Syntax: STDEV.P(number1, [number2], ...) or STDEV.S(number1, [number2], ...)

Example: =STDEV.P(A1:A10) or =STDEV.S(A1:A10)

The STDEV.P function calculates the population standard deviation, assuming
the dataset is a sample from a larger population. The STDEV.S function
calculates the sample standard deviation. These functions return the standard
deviation of a range of numbers.



COVARIANCE

• Covariance is a statistical measure that quantifies the relationship between two variables. It measures how changes in one
variable correspond to changes in another variable. Covariance provides information about the direction (positive or
negative) and magnitude of the relationship between the variables.

• Mathematically, covariance is calculated by taking the average of the product of the deviations of each variable from their
respective means. If the covariance is positive, it indicates that the variables tend to move together in the same direction.
A negative covariance suggests that the variables tend to move in opposite directions.

• A positive covariance indicates that when one variable has a higher value than its mean, the other variable tends to have a
higher value as well. Conversely, a negative covariance indicates that when one variable has a higher value than its mean,
the other variable tends to have a lower value. A covariance of zero suggests no linear relationship between the variables.

• Covariance is used in various fields such as finance, economics, and data analysis. It helps in understanding the
relationship between variables, portfolio diversification, risk assessment, and the selection of variables for regression
models. However, like correlation, the interpretation of covariance should always be done in the specific context of the
data and research question.



CORRELATION

• Correlation refers to the statistical relationship or association between two or more variables. It measures the degree to
which changes in one variable are accompanied by changes in another variable. Correlation is often represented by a
correlation coefficient, which quantifies the strength and direction of the relationship between variables.

• The correlation coefficient, typically denoted by the symbol "r," ranges from -1 to 1. A positive correlation (0 < r < 1)
indicates that as one variable increases, the other variable tends to increase as well. For example, there might be a
positive correlation between studying time and exam scores, suggesting that students who study more tend to achieve
higher scores.

• Conversely, a negative correlation (-1 < r < 0) indicates that as one variable increases, the other variable tends to decrease.
For instance, there might be a negative correlation between temperature and winter clothing sales, indicating that as
temperatures drop, sales of winter clothing increase.

• A correlation coefficient of 0 (r = 0) suggests no linear relationship between the variables. However, it's important to note
that even if there is no linear correlation, there could still be other types of relationships or associations between the
variables that are not captured by the correlation coefficient.



CORRELATION & COVARIANCE

Correlation Covariance

Definition
Measures the strength and direction of the 

linear relationship between variables
Measures how two variables vary together

Scale Dependence Standardized measure (-1 to 1) Depends on the scale of variables

Interpretation
Indicates strength and direction of linear 

relationship
Indicates joint variability of variables

Comparability
Comparable across different datasets and 

variables
Not directly comparable due to scale 

dependence

Units Unitless Product of variable units (e.g., square units)

Range -1 to 1 Unbounded

Relationship 
Assessment

Quantifies linear relationship Quantifies joint variability

Causation Does not imply causation Does not imply causation



COVARIANCE & CORRELATION

COVAR Function in Excel:

Function: COVARIANCE.P & COVARIANCE.S

Syntax: COVARIANCE.P(Array1,Array2) & COVARIANCE.S(Array1,Array2)

array1 and array2 are the two sets of values for which you want to
calculate the covariance.

CORRELATION Function in Excel:

Function: CORREL

Syntax: CORREL(array1, array2)

array1 and array2 are the two sets of values for which you want to
calculate the correlation.



COVARIANCE 
IN DATA 
ANALYSIS 
TOOL IN 
EXCEL

• Click on the "File" tab in Excel.

• Select "Options" from the menu.

• In the Excel Options dialog box, click on "Add-Ins" from the left sidebar.

• In the "Manage" dropdown menu at the bottom of the dialog box, select "Excel Add-ins" and click on 
the "Go" button.

• Check the box next to "Analysis ToolPak" and click "OK". This will enable the Toolpak in Excel.

Enable the Data Analysis Toolpak:

• Once the Toolpak is enabled, click on the "Data" tab in Excel.

• In the "Analysis" group, you should now see a "Data Analysis" button. Click on it.

• In the "Data Analysis" dialog box, scroll down and select "Covariance" from the list of analysis tools.

• Click on the "OK" button.

Calculate Covariance using the Data Analysis Toolpak:

• In the "Covariance" dialog box, select the range of data for which you want to calculate the 
covariance.

• Specify whether the data has headers by checking or unchecking the "Labels in first row" box.

• Choose an output range where you want the covariance matrix to be displayed.

• Optionally, you can select the "Output covariance matrix" option to display the matrix in a symmetric 
form.

• Click on the "OK" button.

Set up the Covariance dialog box:

• The covariance matrix will be calculated, and the output will be displayed in the specified output 
range.

• The resulting covariance matrix will show the covariances between all pairs of variables.

View the Covariance results:



CORRELATION 
IN DATA 
ANALYSIS 
TOOL IN 
EXCEL

• Click on the "File" tab in Excel.

• Select "Options" from the menu.

• In the Excel Options dialog box, click on "Add-Ins" from the left sidebar.

• In the "Manage" dropdown menu at the bottom of the dialog box, select "Excel Add-ins" and click on 
the "Go" button.

• Check the box next to "Analysis ToolPak" and click "OK". This will enable the Toolpak in Excel.

Enable the Data Analysis Toolpak:

• Once the Toolpak is enabled, click on the "Data" tab in Excel.

• In the "Analysis" group, you should now see a "Data Analysis" button. Click on it.

• In the "Data Analysis" dialog box, scroll down and select "Correlation" from the list of analysis tools.

• Click on the "OK" button.

Calculate Correlation using the Data Analysis Toolpak:

• In the "Correlation" dialog box, select the range of data for which you want to calculate the 
correlation coefficients. Make sure to include both variables' data in the same range.

• Select an output range where you want the correlation matrix to be displayed.

• Optionally, you can choose to include the variable names in the output by checking the "Labels in first 
row" box.

• Click on the "OK" button.

Set up the Correlation dialog box:

• The correlation coefficients will be calculated, and the output will be displayed in the specified output 
range you selected in the previous step.

• The resulting correlation matrix will show the correlation coefficients between all pairs of variables.

View the Correlation results:



FREQUENCY DISTRIBUTION & HISTOGRAM

Frequency Distribution:

Frequency distribution is a statistical representation of data that shows
the number of times each value or range of values occurs in a dataset. It
summarizes the data by grouping it into intervals or categories and
displaying the count or frequency of occurrences within each group.
Frequency distributions are commonly used to understand the
distribution and patterns of data.

To create a frequency distribution, follow these steps:

• Sort the dataset in ascending order.

• Determine the range of values covered by the data.

• Divide the range into intervals or categories. The number and width of
intervals depend on the dataset and the desired level of detail.

• Count the number of observations falling within each interval and
record the frequency.

Histogram:

A histogram is a graphical representation of a frequency distribution. It
provides a visual depiction of the distribution of data values and shows
the relative frequencies of different intervals or categories. Histograms
are particularly useful for continuous data, where values can take any
numerical value within a given range.

Here's how to create a histogram:

• Determine the range of values covered by the data.

• Divide the range into intervals or bins. The number and width of bins
can be determined using various methods, such as the square root rule
or Sturges' formula.

• Count the number of observations falling within each bin and record
the frequency.

• Draw a bar for each bin on a graph, where the height of the bar
represents the frequency of observations in that bin. The bars are
usually drawn adjacent to each other without any gaps.

• Label the x-axis with the intervals or bins and the y-axis with the
frequency or relative frequency.



Frequency 
Distribution 
in excel

• Prepare your data: Organize your data in a column or a range. Make sure it contains 
the values you want to analyze.

• Determine the intervals or bins: Decide on the intervals or bins for your frequency 
distribution. These intervals represent the ranges within which you want to group 
your data.

• Set up an array formula: In a new column or range, enter the intervals or bins. 
Then, select a range of cells where you want to display the frequency counts. 
Remember to select an array of cells that has one more cell than the number of 
intervals you have. For example, if you have 5 intervals, select 6 cells.

• Enter the FREQUENCY formula: While the range of cells for the frequency counts is 
still selected, type the following formula:

=FREQUENCY(DataRange, IntervalRange)

Replace "DataRange" with the range of your original data and "IntervalRange" with the 
range containing your interval values. It's important to note that this is an array 
formula, so instead of pressing Enter after typing the formula, you need to press 
Ctrl+Shift+Enter. Excel will display curly braces {} around the formula to indicate that 
it's an array formula.

• View the frequency distribution: The selected range will now display the frequency 
counts corresponding to each interval. You can adjust the formatting and labels as 
needed.



HISTOGRAM USING DATA ANALYSIS TOOL

• Enable the Data Analysis Toolpak:

• Click on the "File" tab in Excel. Choose "Options" from the menu. 

• In the Excel Options dialog box, select "Add-Ins" on the left sidebar. In the Manage box at the bottom of the dialog box, select "Excel Add-ins" and click on the "Go" button.

• In the Add-Ins dialog box, check the "Data Analysis Toolpak" box and click "OK.“ Excel will enable the Data Analysis Toolpak, and you'll find it in the Data tab.

• Prepare your data: Organize your data in a column or range. Make sure it contains the values you want to analyze.

• Open the Data Analysis dialog box:

• Go to the Data tab in Excel.

• Click on the "Data Analysis" button in the Analysis group. If you don't see this button, make sure you have enabled the Data Analysis Toolpak correctly.

• Choose "Histogram" from the list: In the Data Analysis dialog box, scroll down and select "Histogram" from the list of analysis tools.

• Specify the input range and bin range:

• In the Input Range field, select the range of data values you want to analyze.

• In the Bin Range field, select the range of cells that contain the intervals or bins for your histogram.

• Specify the output range: Choose a location where you want the histogram output to be displayed. You can select a new worksheet or specify a range in an existing worksheet.

• Customize the options (optional): You can choose to include a chart, cumulative percentage, or additional statistics by checking the corresponding boxes in the Histogram dialog 
box. Adjust the options according to your requirements.

• Click "OK": Once you have set up the input range, bin range, and output range, click on the "OK" button to generate the histogram.



LINEAR 
FORECAST

Linear forecasting, also known as linear regression forecasting, is a statistical method used to
predict future values based on the relationship between a dependent variable and one or more
independent variables. It assumes a linear relationship between the variables, meaning that the
relationship can be approximated by a straight line.

1. Gather historical data: Collect data for both the dependent variable (the variable you want to
predict) and the independent variable(s) (the variables used to predict the dependent variable)
for a specific time period. The historical data should include a sufficient number of observations.

2. Plot the data: Create a scatter plot of the historical data points, with the dependent variable
on the y-axis and the independent variable(s) on the x-axis. The plot will help you visualize the
relationship between the variables.

3. Determine the linear equation: Use statistical techniques, such as the method of least
squares, to determine the equation of the best-fit line that approximates the relationship
between the variables. The equation will be in the form:

Y = a + bX

Where Y is the dependent variable, X is the independent variable, a is the intercept, and b is the
slope of the line.

4. Calculate the parameters: Calculate the values of the intercept (a) and slope (b) that
minimize the sum of the squared differences between the observed values and the predicted
values on the line. This can be done using regression analysis or other methods.

5. Make predictions: Once you have the linear equation and the estimated parameters, you can
use them to make predictions for future values of the dependent variable. Simply substitute the
values of the independent variable(s) into the equation to calculate the predicted values.

6. Evaluate the forecast: Assess the accuracy of the linear forecast by comparing the predicted
values with the actual values. Calculate performance metrics, such as the mean squared error
or the coefficient of determination (R-squared), to measure the quality of the forecast.



FORECAST.LINEAR FUNCTION

In Excel, the FORECAST.Linear function is used to predict a future value based on a linear regression of existing data. It
calculates the predicted y-value for a given x-value using the least squares method.

The syntax of the FORECAST function is as follows:

FORECAST.Linear(x, known_y's, known_x’s)

x: The x-value or the independent variable for which you want to predict the dependent variable.

known_y's: The array or range of dependent values (y-values) corresponding to the known x-values.

known_x's: The array or range of independent values (x-values) corresponding to the known y-values.



TREND FUNCTION

In Excel, the TREND function is used to predict a linear trend or extend an existing linear series of values. It calculates the y-
values for a given set of x-values based on the linear trendline equation.

The syntax of the TREND function is as follows:

TREND(known_y's, [known_x's], [new_x's], [const])

known_y's: The array or range of dependent values (y-values) corresponding to the known x-values.

known_x's (optional): The array or range of independent values (x-values) corresponding to the known y-values. If omitted,
the function assumes a series of 1, 2, 3, ... as the x-values.

new_x's (optional): The array or range of x-values for which you want to predict the y-values. If omitted, the function uses
the x-values from the known_x's range.

const (optional): A logical value that determines whether to include a constant term (y-intercept) in the regression equation.
By default, it's set to TRUE (include the constant term).
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